
Blender Quick Start Guide

Blender began as an in-house 3D graphics program in the 
1990s and has grown into an incredibly powerful 3D 
animation and visual effects suite of tools.  But perhaps the 
most astounding aspect of Blender is that it’s free.  It 
provides artists all over the world with amazing opportunities 
to create their visions at a very low cost of entry.  Granted, 
you need a computer, and a fairly powerful one at that.  But 
an artist anywhere in the world can download Blender and 
begin creating their dreams.

Having said that, I will be the first to admit that there is a bit 
of a learning curve to using Blender.  It is not an easy 
program to learn, and definitely not an easy one to master.  It 
takes time and practice to learn and internalize Blender’s 
workflow and logic.  But I think, given the right guidance, 
anyone can quickly get up to speed and start creating with 
Blender.  And that’s what this Blender Quick Start Guide 
aims to do: get you started creating your visions in Blender as 
quickly as possible.
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Installing Blender
The first thing you need is, of course, Blender.  If you haven’t 
downloaded the program yet, go to www.blender.org and 
click on the Download button on the main page for the latest 
version.  This will take you to the Download screen where 
you can download the appropriate flavor of Blender for your 
particular operating system.  

Note the system requirements while you are there.  You 
should have at least 8 GBs of RAM in your computer and 
have a reasonably good graphics card, with at least 1GB of 
memory.  These specs will help with the speed at which 
Blender can render the models and images on your screen.  

In addition, you may want to invest in a pen and tablet for 
your computer as well.  I use a Wacom Intuos tablet for 
sculpting and texture painting.  This is extremely helpful and 
provides a lot of control when doing detailed work.  Using 
the mouse in these situations can be very frustrating.  In 
addition, Blender uses many shortcut keys on the keyboard 
number pad.  I use a laptop that does not have a number pad 
so I have purchased a separate Bluetooth number pad.  I pull 
this out whenever I use Blender.  I highly recommend it.  If 
this isn’t an option for you, I’ll talk about how to emulate 
number pad keys later.

Once you have downloaded Blender follow the instructions 
on the website to install the program.  For most operating 
systems all that is required is a simple double-click of the 
downloaded file to install Blender.  

The Blender Interface
When you first open Blender it is a fairly sparse initial 
interface, as 3D animation programs go.  There is a lot 
hidden here and we will not be able to go over every single 
detail in this guide.  But here are the essentials of what you 
need to know to get started.
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Navigation
To move around in Blender’s 3D View, the main thing you 
need to know is that the Middle Mouse Button rules.  

Hold down the Middle Mouse Button (MMB) and move the 
mouse and you will tumble around in the 3D world.  To pan 
the camera back and forth hold down the Shift key and 
click and drag the MMB.  To zoom in and out, hold down the 
Control key and click and drag the MMB.  You can also 
turn the scroll wheel on the mouse to zoom in and out.

So in a nutshell, here’s what you need to know about 
navigating the 3D viewport:

• MMB = Tumble

• Shift + MMB = Pan

• Ctrl + MMB = Zoom

• Scroll Wheel = Zoom

Selection
The selection of objects in Blender is one of those things 
that can turn people off right from the start.  But please stay 
with me and know that there is a certain logic to it.  

To select an object in Blender you use the Right Mouse 
Button.  That’s right, unlike every other program on earth, 
you select things with the right mouse button.  So hover your 
cursor over the camera in the 3D view and click the right 
mouse button.  An orange outline appears around the object 
letting you know that it has been selected.  If you try to 
select an object with the Left Mouse Button, you’ll find that, 
instead of selecting the object, the action just moves a little 
red circle around the screen (we’ll talk about that in a bit).  
It’s a little odd, but once you get into the groove of Blender’s 
way of doing things, it actually works out pretty well.  Try and 
be open-minded about it here at the start but, if if just isn’t 
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working for you, we will soon talk about how to switch to the 
Left Mouse Button.

If you want to select more than one item at a time, hold the 
Shift button down on the keyboard while you click.  Now 
when you right-click another item it will add it to the existing 
collection of  items.  To deselect an item from the selection 
just hold Shift and RMB click it again. 

Now that you have a few objects selected, what if you just 
want to deselect everything?  Well, you can not just click out 
in empty space.  That would move that red circle thing 
around again.  No, to deselect everything just press the A key 
on the keyboard.  And if you hit the A key again it will now 
select every visible object in the scene.  The A key toggles the 
selection of all objects.

Here’s a quick run-down of the selection options we’ve 
discussed so far:

• RMB = select an object in 3D view

• Shift + RMB = add to or remove an object 
from the existing selection

• A key = toggles selection and de-selection 
of all objects visible in the 3D view

Tools and Properties
There are many panels and windows to work with in Blender.  
But two of the most important are the Tool Shelf and the 
Properties Panel.  These allow us to create and modify 
objects in the scene. 
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The Tool Shelf is usually already visible on the left side of 
the Blender interface.  It can be toggled on and off with the 
T key on the keyboard.  

The left side of the Tool Shelf itself holds some handy tabs 
for categories like Tools, Create, Relations, Animation, and  
Physics.  The Tools and Create tabs will probably be what 
you use most as you’re learning Blender.  

On the right side of the 3D viewport is where you will find 
the Properties Panel.  It is often hidden from view when 
you first open Blender, but you can toggle its visibility on and 
off with the N key on the keyboard.  The Properties Panel 
allows you to view and adjust the properties of the objects in 
the your scene.  

For example, select the Cube and at the top of the Properties 
Panel you should now be able to see the fields for its 
Location in the scene.  If you haven’t moved the cube, the X, 
Y, and Z fields will read 0.000.  Below this are the Rotation, 
Scale, and Dimensions fields.  As we move and alter our 
objects in the screen, we’ll be able to see these fields update.  
You can also enter numeric values directly into these fields to 
transform the object.  And if you’re feeling fancy, you can 
even type in an equation, like 2 + 3 in the Location Z, and 
Blender will update the scene accordingly, moving the object 
up 5 units.  

If you scroll down the Properties Panels there are quite a few 
other sections available.  You can change the focal length of 
the camera in the Lens field of the View section.  And you 
can also change the name of the selected object in the Item 
section. 
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Screen Layouts
There are of course many other windows in the Blender user 
interface besides the Tool Shelf and Properties Panel.  And 
they are all remarkably configurable.  In fact, each window 
you see in the Blender interface can be changed, resized, or 
simply removed altogether.  

If you hover your cursor over the border of any two windows, 
you can click and drag to resize those windows.  If you Right-
click on one of these borders you get an Area Options 
menu that allows you to choose between Split Area and Join 
Area.  Use these to split an existing window or combine two 
into one.  

However, any changes you make at this point will be applied 
directly to the Default screen layout.  The Screen Layout 
menu is at the top of the interface.  My suggestion is to 
create a new screen layout before you begin rearranging the 
screen.  That way you always have the Default layout to go 
back to.  

To create a new screen layout you can click on the plus icon 
next to the screen layout pull-down menu.  Give your new 
screen layout a new name and then you can make any changes 
to this new screen layout that you would like.  If you expand 
the pull-down menu you can find the Default layout still 
there for you to go back to.  

There are other screen layouts listed here.  This menu gives 
you several options for configuring the interface based on 
specific yet common tasks for which artists use Blender.  
There are Screen Layouts for 
Animation, Compositing, 
Motion Tracking, and Video 
Editing.  Try one and see what 
you think.  Going through 
each of these and examining 
the different windows in each 
layout provides good insight 
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into how people use the Editor panels as well as how easy it 
is to configure Blender’s interface.  

For example, the top right panel when you first open Blender 
is an Editor window called the Outliner.  The Outliner 
displays a list of the objects in the current scene and allows 
you to adjust their visibility, select-ability, and render-ability.  
But this is just one Editor type that could be displayed in this 
window.  If you click on the button in the top left of the 
panel window you will get a list of all the possible Editors 
that are available.  Several of them are already shown in the 
default layout, like the Properties panel, the Timeline, and 
the 3D view.  But as you can see, there are many more.  

Editor Windows
Each of Blender’s Screen Layouts is made up of multiple 
Editor Windows.  You can access a list of Editor Types by 
clicking on the pull-down menu button in the corner of any 
window.  The list is rather long and many of these you may 
not use for some time, if ever, depending on your needs.  

You can change any window to any Editor type.  So we could 
change the Outliner to the Node Editor, or the Dope Sheet, 
and then back again.  But remember, any change you make is 
applied to the screen layout your using at the time.

Working with Objects
Objects are the building blocks of any 3D model.  You can see 
the base primitive objects that are available by clicking on 
the Create tab in the Tools Shelf on the left.  From here you 
can create Meshes, Curves, Lamps, and other objects such as 
Cameras, Armatures, and Text objects.  

Let’s try this.  If you haven’t already, select the cube in the 
center of the grid with the RMB and hit the Delete key.  You 
will then have to confirm the action by clicking Delete from 
the menu.  
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Now click the UV Sphere button in the Create Tab.  This will 
create a new object at the location of the 3D Cursor (that 
little red circle thingy again.  I promise we’ll talk about that 
soon).  Notice that a new collection of fields and buttons 
appears at the bottom of the Create Tab on the left.  These 
are settings that only appear when you first create an object.  
They allow you to adjust the object before beginning to edit 
it.  If you were to move or alter the object in any way, these 
settings would disappear and would no longer be available.  
They are only here during the initial set-up of the object in 
the scene.

If you change the Segments field to something like 6 and the 
Rings to 8, you can see how this effects the shape and look of 
the sphere.  

Transforming Objects
Now that you’ve created an object, you might as well move it 
around a bit, right?  You’re choices are to Translate, Rotate, or 
Scale the object.  And you can do this in a couple of different 
ways.

First let’s look at the Transformation Manipulators.  You 
can select which manipulator you would like to use at the 
bottom of the 3D View.  Selecting a Transform manipulator 
superimposes the transform gizmo over the selected object 
and by left-mouse-button (LMB) clicking and dragging on 
one of these arrows you can move the object within 3D 
space.  If you click on the Rotate button, you will see a new 
type of circular gizmo superimposed on the selected object.  
Clicking and dragging on one of these rings allows you to 
rotate the object around.  Lastly, if you click on the Scale 
button, you stretch and squash your object by clicking and 
dragging on any of the lines with the small boxes at the end.   

Notice that the colors of each gizmo correspond to the 
colors of the axis in the bottom left of the 3D view.  These 
are the axes of the 3D world inside Blender.  The blue axis is 
the Z axis which represents up and down.  The red axis is the 
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X axis, which represents side to side, or left to right, 
directions in our 3D space.  And the green axis is the Y axis, 
which represents the forward and backward axis in Blender.  

There are of course shortcut keys for Translate, Rotate, and 
Scale.  For Translate, you can press the G key (think “g” for 
grab) and move the mouse.  This moves the object freely in 
3D space.  When you have placed the object where you would 
like, click the Left Mouse Button to confirm the action.  
Likewise, you can press the R key to Rotate, and the S key to 
Scale.  When you press one of these keys and move the 
mouse, however, you don’t have a great deal of control over 
how the object is adjusted.  The object tends to move, rotate, 
or scale in multiple axes.  

You can select a particular axis in which the action should 
take place by adding an extra key-press after the shortcut key.  
For example, let’s say that we’d like to move that sphere in 
the X axis only.  You can press the G key for move and then 
the X key on the keyboard.  Now when you move the mouse 
the object will be constrained to only moving in the X axis.  
This works for rotation and scale as well.  

And you can you can get even 
more fancy with this trick.  Say 
you wanted to move a sphere 
up five grid units.  You could 
press G for move, the Z key 
for the Z axis, and then press 5.  
Your sphere moves up 5 units.  
Now just click the mouse or 
press Enter to confirm the 
action.  This works with 
rotation, but the number you 
enter is the number of degrees to be rotated.  So you could 
press R, then Y, and then type 45.  Your object rotates 45 
degrees around the Y axis.  

You can also indicate which axis you do not want to be 
effected by the action.  For example, if you had a cylinder and 
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you wanted to scale it in the X and Y axes, but not in the Z 
(so it got fatter but not taller) here’s what you could do.  
Select the cylinder and press S for Scale, then press Shift + Z 
to tell Blender that you do not want the Z axis effected, and 
then move the mouse.  Now the cylinder scales only on its X 
and Y axes, increasing its width without increasing its height.

Here are the shortcut key combinations we’ve just discussed:

• G key: Translate (or Move)

• R key: Rotate

• S key: Scale

• G, R, or S and then X, Y, or Z to constrain 
the action to an axis

• G, R, or S, and then X, Y, or Z, and then the 
number of units to be effected

• G, R, or S and then Shift + X, Y, or Z to 
choose the axis that will not be effected by 
the action

The 3D Cursor
OK, I’ve put off talking about the 3D Cursor long enough.  
This is one of those very “Blender things” that you just don’t 
find in too many other animation programs.  In fact, I’ve 
never seen anything like it.  But surprisingly enough, once 
you get used to it, that little red circle thingy comes in pretty 
handy.

The 3D Cursor allows you to snap things to a particular point 
in 3D space.  You can place the cursor somewhere and then 
snap an object to it, or a vertex, or a pivot point; anything 
really.  As you have no doubt already discovered, you can click 
the left mouse button anywhere in the scene and the 3D 
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Cursor will move to that point.  You can also use the Snap 
Menu to move it around.

Press Shift + S to bring up the Snap Menu, and here you can 
choose among several ways of moving the 3D Cursor.  You 
can snap the Cursor to the current selection, to the center of 
the grid, to the nearest grid unit, or to the active object.  
Which you choose depends on what you would like to do.  

Let’s say you had two objects in your scene and you wanted to 
place a point light exactly in the center between these.  You 
could select the two objects, press Shift + S to bring up the 
Snap Menu, and choose the “Cursor to Selected” option.  
This would place the 3D Cursor in the center of the selected 
objects.  Now you could go to the Create Tab on the Tool 
Shelf and click on the Point Light button.  New objects are 
created at the position of the 3D Cursor.  

Another great way to use the 3D Cursor is for moving the 
pivot point of an object.  By doing this you can change the 
point at which an object rotates or scales.  Instead of any 
object rotating at its center point, like a seesaw, it could 
rotate at one end, like a lever.  But to discuss this further, we 
first need to talk about Edit Mode.

Edit Mode
So far we have been working in what is called Object Mode.  
Down at the bottom of the 3D view, there is a menu and it is 
usually set to Object Mode when you first open a scene.  This 
is the Object Interaction menu.  If you click on this you can 
see many other interaction modes.  Switch to Edit Mode 
here, or you can toggle in and out of Edit Mode by simply 
pressing the Tab key.

In Edit Mode you have access to the basic components that 
make up an object: vertices, edges, and faces.  A vertex is just 
a point in space.  It has location, but no size.  An edge is the 
connection of two vertices: a line.  And a face is defined by at 
least three connected edges.
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You can switch between these three basic components by 
choosing the appropriate button at the bottom of the 3D 
View: Vertex Select, Edge Select, or Face Select.  You can also 
switch between the Select Modes by pressing Ctrl + Tab.  
This brings up the Mesh Select Mode menu.  

It is in Edit Mode that the majority of modeling is done.  
Adjusting a 3D model in Object Mode allows you to control 
its scale and proportion, but it is in Edit Mode that the 
details are created.

Pivot Points and Origins
We took a brief detour away from the 3D Cursor to discuss 
Edit Mode, but now we need to revisit the topic to look at 
the concepts of Pivot Points and Origins in Blender.

In most 3D animation programs, the pivot point of an object 
is the same thing as its origin.  The model naturally scales 
from and rotates at its origin, and you are given tools to move 
that origin to wherever you would like.  But the origin and 
the pivot point of an object are always treated as the same 
thing, inextricably intertwined.

Blender however, does this a bit differently.  Every object has 
an origin, and yes we can rotate the object around its origin 
any time we like.  But we can also rotate an object around the 
location of the 3D Cursor, apart from the origin.  This allows 
us to do some pretty tricky stuff once you get to used to the 
idea.  So let’s examine a scenario in which this might be 
useful.  

Let’s say we have a door that needs to rotate at its hinges to 
open.  For animation purposes we would move the origin of 
the object in line with the hinges.  Now when we go to the 
rotate tool the door object will rotate at its hinges.  But what 
if, when setting up our scene, we needed to scale the door up 
from the ground?  We could move the origin to the base of 
the door, scale it, and then move the origin back to where it 
was for opening of the door.  But a more efficient way would 
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be to move the 3D Cursor to the base of the door, and then 
tell Blender to temporarily scale from the position of the 3D 
Cursor.  

How would we do this?  As discussed earlier, pressing Shift + 
S will bring up the Snap Menu.  This allows us to snap the 
cursor to whatever is selected.  So we could select a vertex at 
the base of the door, press Shift + S, and then choose Cursor 
to Selected.  This moves the 3D Cursor to the proper place, 
but now we need to tell Blender to use this as the point from 
which we will scale the door.  

We use the Pivot Point menu at the bottom of the 3D 
View to do this.  The default setting for this is Median Point.  
This usually coincides with the origin of the object.  But if we 
select 3D Cursor from this menu, Blender will use the 
location of the 3D Cursor as the pivot point when we scale 
the door.  When finished we can switch back to Median 
Point.

We can also use the 3D Cursor to move the origin of an 
object.  On the Tool Shelf, under the Tools tab, you will find a 
pull-down menu titled Set Origin.  When you fly the menu 
out you have several options for moving the origin of the 
selected object.  One of them, of course, is Origin to 3D 
Cursor.  

Treating the pivot point and the origin of an object as 
separate things allows us a great deal of freedom when 
working with objects in Blender. 

Essential Modeling Tools
There are many modeling tools in Blender, and the list seems 
to grow with every version update.  But there are two 
essential modeling tools that you must know from the 
beginning.  You can create an amazing array of object from 
just these two tools.  And for both of these, you need to have 
the object in Edit Mode.
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Extrude
The Extrude Tool is one of the most fundamental tools in 
3D modeling.  It is essential for adding new geometry to a 
model.  You can find the Extrude button on the Tool Shelf (T 
key) under the Create tab.  The shortcut for this is the E 
key.  

Let’s give it a try.  Add a Cube into your scene.  Go into Edit 
Mode by pressing the Tab key, and then press Ctrl + Tab to 
bring up the Mesh Select Mode menu.  Choose Face from 
this menu.  Now select a face and press the E key.  When you 
move the mouse Blender will extrude the face along a 
perpendicular line, creating new faces.  You can select and 
extrude multiple faces as well.  

For just about anything you create, you we will be using the 
Extrude Tool quite a bit.  But you can also extrude edges.  
Select an edge and extrude it out.  You’ll see that it pulls a 
single plane out from the edge.  This kind of shape is usually 
not recommended, however.  For several reasons, you usually 
want only two faces to have a common edge.  And for your 
information, you can also extrude a vertex.  But that’s not 
advisable either.  In 3D, as in life, just because you can do 
something doesn’t always mean you should.

Loop Cut and Slide
Loop Cut is an essential tool with which we can add edges 
to our 3D models.  It too has a button on the Create tab of 
the Tool Shelf, and its shortcut key is Ctrl + R.  

After you press Ctrl + R you will need to hover your mouse 
cursor over an edge of the object to get a kind of ghost image 
of the edge loop that will be created.  Move the cursor to 
other edges of the object and the ghost loop will hop from 
one place to another, giving you an indication of where the 
actual edge will be placed.  Once you find the right location, 
click the Left Mouse Button (LMB) to drop a temporary 
edge onto your object.  You can now slide that edge back and 
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forth with the mouse.  When you have placed the edge 
exactly where you want it to go, click the LMB again to 
confirm the action.  

The shortcut keys for the essential modeling tools we have 
discussed are:

• Extrude: E key

• Loop Cut and Slide: Ctrl + R

Modifiers
There are several modifiers that you should know about at 
the beginning of your Blender journey.  They can be found in 
the Properties Window, on the right side of the screen, when 
you click on the Wrench Icon.  The ones that we will be 

discussing are the 
Subdivision Surface and the 
Mirror modifiers.  There 
are many more, as you can 
see in the Modifier pull-
down menu.  But these two 
will serve you well as you 
get up to speed quickly in 
Blender.

The Subdivision Surface 
modifier allows you to 
smooth the polygons of a 
model by virtually and 
interactively subdividing 
the mesh.  You can increase 

or decrease the amount of 
smoothing within the settings of the modifier.  With each 
increase in subdivisions, the model increases in smoothness.  
Ultimately you can apply the smoothing permanently to the 
model by clicking the Apply button.
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To add the Subdivision Surface modifier to an object simply 
select it from the Add Modifier pull-down menu.  Increasing 
the value in the View field will increase the number of 
polygons you see in the 3D View.  You can set a different 
value for how you the object looks in the final render using 
the Render field.  

There are two types of subdivision algorithms that you can 
use to subdivide the object with this modifier.  One is 
Catmull-Clark, which will smooth the object, rounding out 
the edges.  The other is Simple.  Clicking the Simple button 
will allow you to add polygons to the object without rounding 
off the corners.  The button with the Eye icon on it will 
toggle the effect off and on in the 3D view window.  

When using any of the modifiers, keep in mind that the 
changes they make to the object are just a preview.  The 
changes are not applied directly to the object until you press 
the Apply button.  The modifier will then disappear from the 
modifiers list and the changes will be applied permanently.  
But very often you do not have to apply the changes if you 
are using your model solely in Blender.  A model can often be 
rendered and even animated with modifiers added and not 
applied.  

The Mirror modifier is an excellent tool for models like 
characters and vehicles, anything that is symmetrical across a 
center axis.  With this modifier you will be able to model just 
one side of a character and the changes will mirror 
automatically to the other side.  

It is usually best to use the Mirror modifier on an object that 
is in the center of the grid.  I tend to model my objects in the 
center of the grid and then, when finished, move them to the 
proper location in the scene.

To use the Mirror modifier, delete one half of your object and 
then apply the modifier.  You can select to mirror along the 
X, Y, or Z axes.  In the example on the left I’ve chosen the X 
axis.  
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The Merge option is on by default, and should be left on if 
you want the two sides to become one object when you apply 
the modifier.  I generally enable the Clipping function as 
well.  This will allow you to drag points that should be on the 
center line and snap them together.  This helps avoid seams 
down the center of your object.

Keep in mind that this modifier mirrors around the origin of 
the object.  So you may need to use the 3D cursor to move 
the origin to the proper location.  If you are getting 
undesired results from the Mirror modifier, sometimes a 
change in the position of the origin can help.

Like any other modifier, you can click the Apply button to 
make your changes permanent.  For the Mirror modifier, I 
recommend applying the changes before moving on to other 
parts of the modeling process, like rigging a character or 
texturing.  Strange results can occur if you leave this modifier 
in the list while using other tools.

Ultimately, you can add as many modifiers to an object as you 
like, but be mindful of the Evaluation Order of the modifier 
stack.  Blender evaluates and applies the modifiers in the 
stack from top to bottom.  Depending on the modifiers that 
are used, the order in the stack can affect the results that you 
get.  Having a Mirror modifier above a Solidify modifier 
above a Subdivision Surface modifier can give very different 
results than Subdivision Surface, Solidify, then Mirror.  You 
can move individual modifiers up and down in the stack and 
sometimes this just has to be tested to see what the results 
will be with different stack orders.  

Layers
An important part of any project, 3D or otherwise, is 
organization.  And Blender’s layers help you stay organized as 
you create your scene.  The layers are found at the bottom of 
the 3D view.  You can select an individual layer by clicking on 
one of the boxes, or multiple layers by Shift + clicking several.  
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You can also move selected objects from one layer to another.  
Just press the M key on the keyboard and the “Move to 
Layer” window comes up.  You can then select one or many 
layers to move the object to.  

Personalizing Blender
There are a few ways of personalizing Blender that might 
help you work more efficiently.  One is changing the selection 
of objects from the right to the left mouse button.  Another 
is creating shortcut keys for the manipulator tools.  And of 
course, you can change the color scheme of the interface as 
well.  Lastly, we’ll look at how to emulate number pad keys on 
a laptop.  Let’s take a look at each of these.

Mouse Button Selection
Selecting objects with the right mouse button may not be 
everyone’s cup of tea.  I’ve been using Blender for years and it 

still feels odd to me at times.  So if you 
would like to change to using the left 
mouse button, no one will hold it 
against you.  Here’s how…

Go to the File menu at the top of the 
screen and then choose User 
Preferences.  The Blender User 
Preferences window will open.  Now 
click on the Input button at the top of 
the window.  On the left side you will 
find a “Select With:” section with 
buttons for Left and Right.  Click the 
Left button.  

When finished be sure to also click the 
“Save User Settings” button at the 
bottom of the window.  Now when you 
close the window you should be able to 

select objects in Blender with the left mouse button.  For 
most people this will probably feel a lot more intuitive.
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Manipulator Short Cut Keys
I started in 3D animation long ago with programs like 
Lightwave and 3ds Max.  Because of this I got used to having 
short cut keys to switch between the Move, Rotate, and Scale 
manipulators.  I still like the intuitive nature of grabbing a 
manipulator and transforming the object or component in a 
particular axis.  And even though I love Blender, I want the 
ability to switch between manipulators without having to 
click on a button each time.

So here is how I have set up my Blender preferences so that I 
have short cut keys for each of the manipulators.  

We’ll once again need to go into the User Preferences 
window from the File menu.  Click the Input button at the 
top of the window.  In the center there is a long list of items.  
The seventh one down is 3D View.  Twirl down the little 
triangle next to 3D View, and then twirl down the triangle for 
3D View (Global).  

Now you will need to scroll all the down the list until you see 
the “Add New” button.  Click this button and a new item 
called “none” will be added to the list.  Open this up and 
enter the follow information.

In the field that says “none” enter: 
view3d.enable_manipulator

I use the Ctrl + Alt + Left Arrow to choose the Move 
manipulator, the Ctrl + Alt + Down Arrow for the Rotate 
manipulator, and for the Scale manipulator I use Ctrl + Alt + 
Right Arrow.  These are what work for me.  You can choose 
anything you would like, but be careful not to create short 
cut key combinations that are already being used for 
something else in Blender.
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Here is what my preferences look like for the manipulators:

Color Scheme
You can also change the appearance of the Blender user 
interface to suit your personal preferences.  Go back into the 
User Preferences window and click on the Themes button at 
the top.  On the left is a pull down menu with various color 
themes for the interface.  

One word of caution, before you begin trying out these 
various themes make a Default preset so you can get back to 
the current theme easily.  Just click on the + button next to 
the Preset menu and name the new preset “Default.”  Now 
you can always get back to the way Blender was at install 
without having to use the Load Factory Settings option in 
the File menu.

In addition to the Preset menu, Blender gives you the option 
of modifying just about every detail of the interface.  I have 
never felt comfortable delving into each little setting in this 
window.  Just knowing that I have the power to do so has 
been enough for me.
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Emulating Number Pad Keys
If you are using a laptop that does not have a number pad, 
you can change Blender’s preferences to use the standard 1 
through 0 keys at the top of the keyboard.  Access the User 
Preferences window from the file menu and click the Input 
button at the top of the window.  Place a check mark in the 
box by “Emulate Numpad.”  Now click the “Save User 
Preferences” button at the bottom of the screen.

Essential Shortcut Keys
There are a lot of short cut keys to remember in Blender.  No 
one can remember them all.  But here are a few that I think 
are essential to know early in the learning process.  

G Move

R Rotate

S Scale

Z Wireframe Shading

A Select All/Deselect toggle

X Delete

T Tool Shelf

N Properties Panel

M Move to Layer

Tab Edit Mode/Object Mode toggle

Shift + S Snap Menu

Space Search

Ctrl+Alt+Q Quad View toggle

C Circle Select

B Border Select
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Shift + D Duplicate

Numpad 1 Front View

Numpad 3 Right View

Numpad 7 Top View

Numpad 5 Orthographic/Perspective Views

Edit Mode:

E Extrude

Ctrl + R Loop Cut and Slide

W Specials menu

Ctrl + V Vertices Menu

Ctrl + E Edges Menu

Ctrl + F Faces Menu

Conclusion
Thank you for joining me on this brief Quick Start tour of 
Blender.  I hope it’s been helpful.  Blender is a wonderful 
program and an incredible artistic tool.  It is not the easiest 
application to learn, but it is well worth the effort to be able 
to tap into its amazing creative power.  

If you would like to learn more about Blender, please 
consider my online course Blender Scene Creation, a project-
based introduction to Blender and 3D animation. 

In this course you'll go through the process of creating an 
animated scene from scratch.  From the first polygon to the 
final render.  You'll learn all the steps involved in bringing 
your own animations to life. 

We will start with Blender's user interface and navigation 
tools, providing you with a solid foundation before moving 
forward.  We’ll then begin modeling a mechanical character 
and its environment.  
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You'll learn how to UV map your 3D objects and texture 
them. We'll use GIMP to prepare the textures, and the node 
editor to apply them to Cycles materials.  

You'll learn how to rig and animate the mech, as well as 
animate the camera in the scene.  We'll create volumetric 
lighting and even create a jet flame effect for the mech's jet 
pack.

Finally, you'll learn how to render out your animation and use 
Blender's video sequence editor to create a Quicktime movie.

This course contains 69 videos, more than 11 hours of 
content, and can be downloaded or streamed on any device: 
computer, tablet, or smartphone.  

Topics covered:

• Blender Interface and Navigation

• 3D Modeling

• UV Mapping

• Materials and Texturing

• Rigging

• Animation

• Lighting

• Physics Effects

• Rendering

Find out more about Blender Scene Creation at 
www.darrinlile.com

Learn Blender quickly so you can you can bring your visions 
to life.  I can’t wait to see them!

Thank you!
Darrin Lile
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